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WELCOME TO CREDLY 
Welcome to a new way of managing your professional achievements and learning outcomes—badging 
with Credly.  Credly is leading the digital credential movement, making talent more visible and 
opportunity more accessible. 
 
Whether that’s entering the job market for the first time, moving forward in your existing profession, or 
making a career change, we’re dedicated to helping you set yourself apart by representing valuable skills 
unique to your experiences in a way that is sharable and verifiable.  
 
In this document, we’ll teach you everything you need to know about badges 

• What are badges 
• How they can tell your professional story 
 

We’ll also provide step-by-step instructions for navigating the Credly platform to manage and share your 
badges  

• Setting up a Credly profile 
• Accepting/managing badges 
• Sharing badges 
 

The Credly platform was built mobile-first, so your experience with the platform will be just as good on 
your Android or Apple IOS mobile device as it is on a desktop computer.  
 
Credly’s platform is supported by modern web browsers, so if you experience any issues with the website 
make sure your browser is an up-to-date version – at least Internet Explorer 9, Mozilla Firefox 4, Google 
Chrome, or Safari 6. 
 
If at any time you have further questions, or are experiencing issues with your Credly account, access the 
Credly support forum: https://support.credly.com/hc/en-us. 

WHAT IS A BADGE? 
Badges are digital assets used to communicate a learning achievement or credential. Credly badges link to 
metadata that provides context and verification. They can be shared across the Internet for maximum 
visibility and recognition. 
 
Badges are a standard to recognize and verify learning. A badge communicates three things without 
sacrificing verification or context: 

• Who did something? 
• What did they do? 
• Who says they did it? 

 
You can earn a badge for lots of different things, from many different organizations.  What makes the 
badges issued to you from Credly unique is that they represent achievements valued by employers. 
Badges managed through Credly will help you tell your professional story in a way that is complete and 
validated.  
 

https://info.credly.com/
https://support.credly.com/hc/en-us
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You can share your badges with anyone you’d like, wherever you’d like: 

• LinkedIn 
• Facebook 
• Twitter 
• Via email 
• Embedded in a website 

A viewer can click on your badge and will be taken back to Credly to view all the details of your 
achievement. You can also share your complete Credly profile to provide an employer with the full 
context of your abilities, represented by the various badges you’ve earned and manage through the 
Credly platform. 

GETTING STARTED 
There are two steps to getting started with Credly: 

● Have an organization issue you a badge 
● Create an account and claim your badge 

Receive a Badge 
How do you know if you’ve been issued a badge? You’ll receive an email from Credly that looks like the 
item pictured below.  Click on the Accept button below your badge image. This will  will take you to the 
Credly website where you will create an account. 
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Accidental Badge Rejection 
If you accidentally rejected your badge? Please contact Credly support by submitting a request. One of 
our representatives will resend the badge notification email for the rejected badge.  Doing so places the 
badge back into a pending state and allows you to access your account and accept the badge from your 
dashboard. 

Create an Account 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fill in each field, then read and agree to the Terms of Use and Privacy Policy. Let us know if you’d like to 
receive occasional messages from us. These messages will contain information to help you make the 
most of Credly. You can change your preferences for receiving marketing emails from Credly at any time.   
 
Click Create Account.  You’ll see this message on your screen: 
 
 
 
 
 
 
 
 
 
 
 
Check your email and follow the instructions there to continue.   
 
 
 
 
 
 
 
 

https://info.credly.com/
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You will be prompted to sign in with the credentials you created. 
 

 

 

 

 

 

 

 

 

 

Claim Your Badge  
Once you sign into your account, you will be able to claim your badge.  

 
 
 
 
 
 
 
 
 
 
 
 
 
Personalize Your Profile 
Your Credly profile is an important part of telling your professional story. It’s one spot on the web where 
you can manage and share the achievements that will further your career, so make sure to include a few 
key elements: 

• Name – Is your name Katherine, but you go by Kate? Edit your name to best reflect what you’d 
like to be called at work.  

• Profile picture – make sure it’s a nice one that represents you as you’d like to be viewed by 
potential employers. The minimum size is 196 x 196 pixels.  

• Bio – This is where your professional personality can really shine through. You’ve got 500 
characters to sketch out your key talents, qualifications, and interests.  

 

https://info.credly.com/
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To personalize or edit your profile, click on the Profile icon at the top right corner of any screen and select 
Settings. Then, click Profile from the left sidebar menu. 

 
 
 
 
 

 
 
 
 

 
 

 

 

 

 

From this page, you will be able to add a photo and a brief bio along with other details. 

 
 
 
 
 
 
 
 
 
 
Share Your Badge 
Using Credly's sharing options, earners can share their badges directly to social media sites such as 
LinkedIn, Twitter, and Facebook, add their badge to their email signature, post the badge on a website or 
download a copy to use on printed collateral. All this can be done from their Credly account.  To share 
your badge: 

1. Log into your account on www.yourCredly.com  
2. Select the badge you'd like to share 
3. At the top of the page, select the blue "Share" button 
4. You will be brought to the “Share Badge” screen where you can find different tabs directing you 

to connect your social media accounts and share your badge 
 
Once your social media account is connected, just click “Share” to share your digital badge 

https://info.credly.com/
http://youracclaim.com/
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Add Your Badge To Your Email Signature 
Email clients handle images within signatures differently. Some, like Outlook, require a resized image and 
a hyperlink. 
 
First, let's find the assets you’ll need from your badge on Credly.  
 
1. Log into your account and select the badge you’d like to 

add to your email signature from your Dashboard.    
2. Select the share button at the top the page. This will 

show you all of your possible share options for this 
badge. 

3. Select the tab with the download icon and use the 
sliding scale to select the appropriate size for your 
image download. (We recommend around 150x150 
pixels, in this case.) Click the "Download Image" button 
(see below).  

4. Select the tab with the link icon and click the "Copy" 
button to copy the Badge URL your clipboard. You'll 
need this to hyperlink your downloaded image. 

  
Using Outlook: 

1. Start a new email and click signature 
2. Either edit an existing signature or add a new one. 
3. Select the image icon and choose the image you downloaded. 
4. Next hyperlink the image. Paste the badge URL you copied . 
5. Select Save. 

 

https://info.credly.com/
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Add Your Badge To LinkedIn  
You'll want to first go to your  Dashboard and click into the badge you'd like to share.  
 
Next click the blue Share button at the top of the page. Clicking Share will bring you to all of the badge 
share options available.   
  

 
   
If you haven't connected your LinkedIn account with your  profile choose Connect.  You will then be asked 
to sign into your LinkedIn account and allow Credly to access.  
 

Credly LinkedIn Account Access Requirement 
To share or add a badge to your LinkedIn profile, LinkedIn requires an authorization process that is 
required and standard for all third-party programs creating a connection between the two accounts.  
LinkedIn predetermines this message based on the authorization scope required to share your 
badge. Credly will not post to LinkedIn without your initiation or permission. Credly will only add badges 
to your profile or post them to your newsfeed upon request. 

  
LinkedIn provides permissions in three levels. While we will never like 
or comment on content, that level of access is required in order to 
provide the other sharing services we offer, like posting badges.  An 
example of the message you will receive when connecting your Credly 
and LinkedIn accounts is as follows: 
  
You can disconnect Credly access to your social media account after 
you have successfully shared your badge to your profile or feed. You 
can also manage Credly's connection through your privacy settings 
within your social media account. 
  
 

 
Once connected, you'll see both options to Add to profile or Share to Feed (sharing to your Feed allows 
you to enter a custom message). If you'd like to only add your badge to your profile, uncheck Share to 
Feed and vice versa if you'd like to only Share to your Feed.  
 

https://info.credly.com/
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Next select Share To LinkedIn.  
  
LinkedIn will open in a new window, 
populating all of your badge information.  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Next Click Save and your badge will post to your LinkedIn Profile.  
  

https://info.credly.com/


  Badge Earner Guide 

   © CREDLY 2020 | CREDLY.COM |  11 

 

 

Issuing Organization Name Not Populated 
If you notice that the Issuing organization is not populated, you can type in the name of the issuing 
organization within this field.  

 
Your badge will then appear under the License and Certification section of your LinkedIn profile. Only the 
Issuing organizations logo will appear next to your badge information. Clicking See Credential will take 
anyone viewing this badge from your LinkedIn profile to the badge assertion page within your  profile.  
  

 
  
When Sharing your badge to your Feed,  you will see the badge image itself.  
  

 
 

https://info.credly.com/
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Incorrect  Badge Display 
If your badge is displaying the incorrect title and/or 
visual on LinkedIn please delete the badge in your 
profile and or newsfeed and reshare from the Credly 
platform. 
  
You can delete a badge in your profile by clicking the 
edit button next to the badge. Once you select the 
button, scroll down, and select "Delete" 
  
You can delete a badge from your newsfeed by 
selecting the edit icon in the right-hand corner and 
clicking "Delete". 
 
 

 
Add Your Badge To Twitter 
Go to your  Dashboard and click into the badge you'd like to share. Next click the blue Share button at the 
top of the page.  
  

 

Clicking Share will bring you to all of the badge share options available.   
  
Click the Twitter icon then the Connect button to Credly to access your account.  
 
To share a badge to your Twitter profile, Twitter requires an authorization process, that is required and 
standard for all third-party programs creating a connection between the two accounts. Twitter 
predetermines this message based on the authorization scope required to share your badge. Credly will 
not post to Twitter without your initiation or permission. Credly will only add badges to your Twitter feed 
upon request. Here is an example of the message you will receive when connecting accounts: 

https://info.credly.com/
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Please also see the Help 
Center link in the message 
from the Twitter Help Center 
on "About third-party log in 
sessions."  
  
NOTE: You can disconnect 
Credly access to your social 
media account after you have 
successfully shared your 
badge to your profile or 
newsfeed. You can also 
manage your 
Credly  connection through 
your privacy settings within 
your social media account. 
 
 
 
 
 
 

Adding Your Badge To Facebook 
To Share your badge via Facebook Messenger using your mobile device, follow these steps: 
 
1. Log into your account on https://www.credly.com/users/sign_in  
3. Click on the badge you are looking to share to Facebook. 
4. At the top of the page click "Share" 
5. You will be brought to the "Share Badge" screen where you can connect your social media accounts 
and share your badge.  
  

https://info.credly.com/
https://help.twitter.com/en/managing-your-account/connect-or-revoke-access-to-third-party-apps
https://help.twitter.com/en/managing-your-account/connect-or-revoke-access-to-third-party-apps
https://www.credly.com/users/sign_in
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Embedding A Badge in a Website? 
To embed your badge in a website, you’ll first need to make sure you have accepted the badge and made 
it public. 

 
 
Next, navigate to the symbol that looks like </>  
 

 
 
Click on the symbol to display your embed code. Put that code into the html on your site. 
 

 
If that wasn’t your question and what you really wanted was only the badge image for publication, use 
the next button to the right of the embed. That allows you to download only the image. 
 
Syncing Badges With ZipRecruiter? 
Sync to ZipRecruiter is a new feature on Credly that enables you to sync your badges to ZipRecruiter to 
promote your achievements to employers and to be matched to jobs relevant to your skillset.  Follow the 
instructions below to establish your connection and sync your badges with ZipRecruiter 
 
NOTE: All badges can be synced to ZipRecruiter,  but the share to ZipRecruiter option is not shown for 
every badge 
 
To establish your connection through Credly, click into a badge from your dashboard and choose share.  
  

https://info.credly.com/
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Select The ZipRecruiter icon and select “Connect” to begin connecting to ZipRecruiter 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
You will be taken to a co - branded 
page to create or sign into your 
ZipRecruiter Account. 
 
 
 
 
 
 
 
 

https://info.credly.com/
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If you are creating a profile with ZipRecruiter upon completion you will be prompted to import from 
Credly.  
 

 
 
If you already have a ZipRecruiter profile, sign in and you'll be prompted to import from Credly.  

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click Import from Credly, will then display your option to 
sign into your Credly account.  
 
 
 
 
 
 
 
 
 
 

https://info.credly.com/
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After you sign in, click to allow ZipRecruiter to connect to your Credly account.  
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: ZipRecruiter predetermines this message based on the authorization scope required to share your 
badge. Credly will not sync your badges to ZipRecruiter without your initiation or permission.  
  
When you’re connected, return to ZipRecruiter and select the badges you’d like to display.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
NOTE: When you add badges to ZipRecruiter, all of the badges that you have marked as public within your 
Credly profile will appear on your ZipRecruiter account. You will have the opportunity to edit what badges 
you’d like to have appear through the ZipRecruiter interface.  
 
Your badges will appear on your ZipRecruiter profile.  
 
  

https://info.credly.com/
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NOTE: Badge images will not appear on ZipRecruiter at this time.  

Download A Copy Of Your Badge 
  

1. Locate the badge you'd like to download on 
your dashboard and click into the badge.  

2. Select the "Share" button at the top of the 
page to see your badge sharing options. 

 

 

 

3. Select the ↓ symbol. 

4. Use the slider to adjust image size (image 
can be adjusted as small as 60px X 60px and 
as large as 600px X 600 px. 

5. Click the download Image button at the 
bottom of the page to download. 

6. If desired, use the URL option to embed the 
badge link with the image for sharing in an 
email signature, resume and more. 

NOTE: Image will download in PNG format.  To convert to other formats (i.e., Gif, TIF, JPEG, etc.) do the 
following: 
 

https://info.credly.com/
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• On a PC:  
1. Save the PNG image then open it with Windows Paint. 
2. Navigate to File > Save as and choose the format you want to convert to from the list of 

options.   
3. Save the converted image.   

 
• On a Mac 

1. save the PNG image then open it in Preview. 
2. Navigate to File > Export and choose the format you want to convert to from the list of 

options. 
 If you do not see the format you are looking for, hold down the Option key while 

selecting the Format menu and additional format types will appear. 
3. Save the converted image.  

CREDLY ORGANIZATION BADGES 
Managing An Organization Badge 
There are two types of badges issued on Credly: user badges and organization badges. 
  
An organization badge is issued to an organization but is managed by an individual on behalf of the 
organization.   Though the badge is connected to your email address, it will feature your organization's 
name in the Issued To field. It will appear in your badge management section, but it will not be displayed 
on your personal public profile. If your organization issues badges on Credly, the badge will appear on 
your organization's public profile page under "Earned Badges". 
 
In order to share the badge on behalf of your organization, select the badge and click the Share icon. You 
will need to disconnect any personal social media accounts and connect your organization's social media 
accounts. You'll then be able to share the badge to each destination, as desired. You can also use the 
provided embed code to post the badge on your organization's website. 
 
Adding An Organization Badge To Your Organization’s Facebook Page 
Easily share your badge to your organization's page by either creating a post and pinning it to the top of 
your page or adding your badge image and URL to a photo album.  
 
Create a post with your badge 

1. Log into your account on https://www.credly.com/users/sign_in  
2. From your Dashboard, select the badge you'd like to share 
3. Click "Share" 
4. You will be brought to the "Share Badge" screen 
5. Next, click the URL tab and copy the public-facing URL associated with your badge     
6. Now, open another tab in your internet browser and go to your organization's page on Facebook   
7. Click "Write something..." to begin your post 
8. Paste your badge URL  
9. Click "Publish" 
10. If you'd like this post to remain at the top of your page's newsfeed, click the arrow at the top right 

corner and click "Pin to Top of Page"  
 

https://info.credly.com/
https://www.credly.com/users/sign_in
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Add and hyperlink a photo of your badge 
1. Log into your account on https://www.credly.com/users/sign_in  
2. From your Dashboard, Select the badge you'd like to share 
3. click "Share" 
4. You will be brought to the "Share Badge" screen  
5. Click the downward facing arrow tab to download your badge 
6. Select your preferred size and click "Download Image" 
7. Next, click the URL tab and copy the public-facing URL associated with your badge 
8. Now, open another tab in your internet browser and go to your organization's page on Facebook 
9. Go to the "Photos" section of your page and click "Add Photos" 
10. Upload your badge visual 
11. Under “Say something about this photo….” Paste your badge URL 
12. Click “Post” 

ADDITONAL RESOURCES 
Labor Market Insights 
Credly offers badge earners labor market insights, directly connected to the skills represented by badges. 
If the issuing organization for your badge has enabled this feature, you'll be able to view the following 
real-time insights from job requisitions: 
 

• Top locations that are hiring for a particular skill 
• Top job titles 
• Top employers 
• Top job functions 
• Related certifications and skills 
• Salary ranges associated with those jobs 

Find Job Openings, Labor Market Insights And Other Digital Credentials 
Did you know, you can use Credly to find job openings, labor market insights, and digital credentials that 
match the skills you have, or the skills you’re looking to develop. And, you can do this, even if you haven’t 
yet earned any digital credentials on our platform. 
 
Just visit Credly.com,  Sign in or create an account, confirm your email address, and use the search 
feature in the upper right corner to find specific credentials, badges, or skills.   
 
To use the search feature: 

• Select the magnifying glass at the top of the page.  
• Enter a Skill, Badge, or Issuer. 
• Click into any of the results to view Labor Market Insights 

https://info.credly.com/
https://www.credly.com/users/sign_in
https://www.youracclaim.com/
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Use the left-hand navigation to search specifically for a Badge, Skills, or Issuers.  
Selecting a result from the listed “Skills” will take you to our Labor Market Insights. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Notice at the top of the page, a hyperlink that shows your location. Selecting this link will give you the 
option to tailor your search results by your location.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select “Postings” to the right of each result to see results for related jobs.    

https://info.credly.com/
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Scroll down to the bottom of the page to see related badges.  
 

 
 
 
 
 
 
 
 
 
 
 
 

Selecting “View All” will surface a full page of related badges.  
 
Selecting a listed result from  “Badge” will take you directly to the Badge Assertion page.  

 
 
 
 
 
 
 
 
 
 
 
 
 

As an example, let’s select the “Engineer" badge.  

https://info.credly.com/
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From the Badge Assertion page, you’ll find the following information about that specific badge.  
• A description of the badge 
• Demonstrated Skills  
• Earning Criteria  
• The Type of badge  
• Time to earn the badge 
• Level of the badge 
• Cost - was the badge earned in a free or paid course by the issuing organization.  
• Additional details will take you to the issuing organizations landing page.  

  
Selecting “Organizations” from the listed results will take you directly to the Issuers page. From this page, 
you can browse the Issuers badge catalog to see all badges offered. Select any badge to view the full 
badge assertion page.  

https://info.credly.com/


  Badge Earner Guide 

   © CREDLY 2020 | CREDLY.COM |  24 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
NOTE: If the issuer offers badge collections, you’ll see a “Collections” option. Selecting collections will 
take you to the issuers’ collections of badges.  
 
You can also sort badges from an Issuer page by “Most Popular” and Most Recent.  
 
If you have any questions or need help using the Credly platform, please Submit a Request. Credly’s 
support staff will be happy to assist.  
 

https://info.credly.com/
https://support.youracclaim.com/hc/en-us/requests/new
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